
	   1	  

Operating System Installation 
Hard Drive Setup Procedures 

Hard Drive Partitioning 
As a technician, you might have to perform a clean installation of an OS. Perform a clean install in the following 
situations: 

• When a computer is passed from one employee to another  

• When the OS is corrupt  

• When the primary hard drive is replaced in a computer  

The installation and initial booting of the OS is called the operating system setup. Although it is possible to install an 
OS over a network from a server or from a local hard drive, the most common installation method for a home or small 
business is with CDs or DVDs. To install an OS from a CD or DVD, first configure the BIOS setup to boot the system 
from the CD or DVD. 

Important: If the hardware is not supported by the OS, you may need to install third party drivers when performing a 
clean installation.  

Partitioning  

A hard drive is divided into specific areas called partitions. Each partition is a logical storage unit that can be formatted 
to store information, such as data files and applications. During the installation process, most operating systems 
automatically partition and format available hard drive space. 

A technician should understand the process and terms relating to hard drive setup.  

• Primary partition - This primary partition containing the operating system files is usually the first partition. 
There can be up to four primary partitions per hard drive. A primary partition cannot be subdivided into smaller 
sections.  

• Active partition - The OS uses the active partition to boot the computer. Only one primary partition per disk 
can be marked active. In most cases, the C: drive is the active partition and contains the boot and system files. 
Some users create additional partitions to organize files or to be able to dual-boot the computer. 

• Extended partition - The extended partition normally uses the remaining free space on a hard drive or takes the 
place of a primary partition. There can be only one extended partition per hard drive, but it can be subdivided 
into smaller sections called logical drives.  

• Logical drive - A logical drive is a section of an extended partition. It can be used to separate information for 
administrative purposes.  

• Basic disk - A basic disk (the default) contains primary and extended partitions, as well as logical drives. A 
basic disk is limited to four partitions.  
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• Dynamic disk - A dynamic disk has the ability to create volumes that span across more than one disk. The size 
of the partitions can be changed after they have been set. Free space can be added from the same disk or a 
different disk, allowing a user to efficiently store large files. After a partition has been extended, it cannot be 
shrunk without deleting the entire partition. 

• Formatting - This process prepares a file system in a partition for files to be stored.  

• Sector - A sector contains 512 bytes.  

• Cluster - A cluster is also called a file allocation unit. It is the smallest unit of space used for storing data. It is 
made up of one or more sectors.  

• Track - A track is one complete circle that can contain data on one side of a hard drive platter. A track is 
broken into groups of sectors.  

• Cylinder - A cylinder is a stack of tracks lined up one on top of another to form a cylinder shape.  
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Hard Drive Formatting 
A clean installation of an OS proceeds as if the disk were brand new. No information that is currently on the hard drive 
is preserved. The first phase of the installation process partitions and formats the hard drive. This process prepares the 
disk to accept the new file system. The file system provides the directory structure that organizes the user’s operating 
system, application, configuration, and data files. 

Windows operating systems use one of these file systems: 

• New Technology File System (NTFS) - Supports partition sizes up to 16 exabytes, in theory. NTFS 
incorporates more file system security features and extended attributes than the FAT file system.  

• File Allocation Table, 32 bit (FAT32) - Supports partition sizes up to 2 TB or 2,048 GB. The FAT32 file 
system is used by Windows XP and earlier OS versions. 

The preferred file system type for a clean installation of Windows is NTFS. Security is one of the most important 
differences between FAT32 and NTFS. NTFS can support more and larger files than FAT32 and also provides more 
flexible security features for files and folders. Figure 1 is a comparison of the Windows file systems.

 

To use the extra security advantages of NTFS, you can convert partitions from FAT32 to NTFS using the 
CONVERT.EXE utility. To make an NTFS partition a FAT32 partition, back up the data, reformat the partition, and 
restore the data from a backup. 

CAUTION: Before converting a file system, remember to back up the data. 
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Windows 7 and Windows Vista automatically create a partition using the entire hard drive. If a user does not create 
custom partitions using the New option, as shown in Figure 2, the system formats the partition and begins installing 
Windows. If users create a partition, they will be able to determine the size of the partition. In Windows 7 and 
Windows Vista, there is no option to select a file system. All partitions are formatted with NTFS.

 

Before users can install Windows XP, they must create a new partition. When a user creates a new partition, they will 
be prompted to choose the size of the partition. After a partition has been created, Windows XP provides users with a 
choice of formatting it with the NTFS or FAT file systems. A technician should also be familiar with the following 
multimedia file systems: 

• exFAT (FAT 64) - Created to address some of the limitations of FAT, FAT32, and NTFS when formatting 
USB flash drives, such as file size and directory size. 

• Compact Disc File System (CDFS) - Created specifically for optical disk media. 
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Quick Format versus Full Format  

When installing Windows XP, you can format a partition using a quick format or full format, as shown in Figure 3. The 
quick format removes files from the partition, but does not scan the disk for bad sectors. Scanning a disk for bad sectors 
can prevent data loss in the future. For this reason, do not use the quick format for disks that have been previously 
formatted. The quick format option is not available when installing Windows 7 or Windows Vista.

 

The full format removes files from the partition while scanning the disk for bad sectors. It is required for all new hard 
drives. The full format option takes more time to complete.  
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Installation with Default Settings 
When a computer boots with the Windows 7 installation disc (or USB flash drive), the installation wizard presents 
three options, as shown in Figure 1: 

• Install now - Sets 
up and installs the Windows 
7 OS.  

• What to know 
before installing Windows 
- Opens a Help and Support 
window describing the 
Upgrade and Custom 
options for installing 
Windows 7. The window 
also describes how to 
prepare for and install 
Windows 7. 

• Repair your 
computer - Opens the 
System Recovery Options 
utility to repair an 
installation. Select the 
Windows 7 installation that 
needs repair and click Next. 
You can then select from a 
number of recovery tools, 
such as Startup Repair. 
Startup Repair locates and 

repairs problems with the OS files. If Startup Repair does not solve the problem, additional options, such as 
System Restore or System Image Recovery, are available. 

NOTE: Before performing a repair installation, back up important files to a different physical location, such as a 
second hard drive, optical disc, or USB storage device. 

For this section, select the Install now option. Three options are available:  

• Upgrade - Upgrades Windows but keeps your current files, settings, and programs. You can use this option to 
repair an installation. 

• Custom (advanced) - Installs a clean copy of Windows in your choice of location and allows you to change 
disks and partitions. It is also known as a clean installation. Selecting a custom installation increases the 
likelihood of a successful installation. 

• Quit - Exits Setup. 
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If existing Windows installations are not found, the Upgrade option is disabled, as shown in Figure 2. 

 

NOTE: Unless you perform a clean installation of Windows 7, the previous Windows folder is kept, along with the 
Documents and Settings and Program Files folders. During the Windows 7 installation, these folders are moved to a 
folder named Windows.old. You can copy files from the previous installation to the new installation if you need them. 

During an installation, you must provide the following information:  

• Language to install 

• Standards and formats that define currency and numerals  

• Keyboard or input method 

• Physical location of the installation 
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• Username and computer name 

• Password for the administrative account 

• Product key 

• Time and date settings 

• Network settings 

Network Settings  

When configuring initial network settings during installation, you are prompted to select one of the following current 
locations, as shown in Figure 3: 

• Home 
network 

• Work 
network 

• Public 
network 

Depending on the 
current location of 
the computer and 
version of the OS, 
you are prompted to 
select a method for 
organizing 
computers and 
sharing resources on 
a network. The 
options are 
Homegroup, 
Workgroup, and 
Domain. 

If Home network is 
selected, you are 
prompted to enter 
the name of a 

workgroup, with the option of configuring a homegroup. A workgroup provides a network structure that permits file 
and printer sharing. All computers in a workgroup must have the same workgroup name. A homegroup allows 
computers on the same network to automatically share files, such as music and pictures, as well as printers. 

If Work network is selected, you can choose to enter the name of a domain or a workgroup. A computer on a domain 
is governed by a central administrator and must follow the rules and procedures set by the administrator. A domain, 
like a workgroup, provides users with the ability to share files and devices. 
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Account Creation 
When users attempt to log in to a device 
or to access system resources, Windows 
uses the process of authentication to verify 
that the users are who they say they are. 
Authentication occurs when users enter a 
username and password to access a user 
account. Windows OSs use Single-Sign 
On (SSO) authentication, which allows 
users to log in once to access all system 
features versus requiring them to log in 
each time they need to access an 
individual resource. 

User accounts allow multiple users to 
share a single computer, with each user 
having their own files and settings. 
Windows 7 and Windows Vista have three 
types of user accounts: Administrator, 
Standard, and Guest. Each account type 
provides a user with a different level of 
control over system resources. 

An account with administrator privileges must be created when Windows 7 is installed, as shown in the figure. A user 
with administrator privileges can make changes that impact all users of the computer, such as altering security settings 
or installing software for all users. Accounts with administrator privileges should be used only to manage a computer 
and not for regular use, because drastic changes that affect everyone can be made when using the administrator 
account. Attackers also seek out an administrator account because it is so powerful. For this reason, it is recommended 
that a standard user account is created for regular use. 

Standard user accounts can be created at any time. A standard user account has fewer permissions than an administrator 
account. For example, users might have the right to only read, but not modify, a file. 

Individuals without a standard user account on the computer can use a guest account. A guest account has limited 
permissions and must be turned on by an administrator. 

To create or remove a user account in Windows 7 and Windows Vista, use the following path: 

Start > Control Panel > User Accounts > Add or remove user accounts  

Windows XP features a fourth group of users called Power Users. Power Users have privileges that are extended 
beyond those of standard users, providing them with some of the capabilities given to Administrator accounts. Power 
users are not able to fully administrate system resources. The group has not been included in Windows 7 or Windows 
Vista. 

To create or remove a user account in Windows XP, use the following path: 

Start > Control Panel > User Accounts > Select the Users tab and click Add 
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Complete the 
Installation 
After the Windows installation 
copies all the necessary OS 
files to the hard drive, the 
computer reboots and prompts 
you to create a user account. 

Windows 7 must be registered. 
As shown in Figure 1, you 
must also complete the 
verification that ensures that 
you are using a legal copy. 
Doing so enables you to 
download individual updates 
called patches. A service pack 
is just several patches grouped 
together. 

Windows Update  

Depending on the age of the 
media at the time of your 
installation, there might be 
updates to install. As shown 
in Figure 2, you can use the 
Microsoft Update Manager 
from the Start Menu to scan 
for new software, as well as 
install service packs and 
patches.  

To install patches and 
service packs in Windows 7 
or Windows Vista, use the 
following path: 

Start > All Programs > 
Windows Update  

To install patches and 
service packs in Windows 
XP, use the following path: 

Start > All Programs > 
Accessories > System Tools 
> Windows Update  
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Device Manager  

After installation, verify that all hardware is installed 
correctly. As shown in Figure 3, you can use Device 
Manager to locate problems and to install the correct or 
updated drivers in Windows 7 and Windows Vista 
using the following path: 

Start > Control Panel > Device Manager  

In Windows XP, use the following path: 

Start > Control Panel > System > Hardware > 
Device Manager  

In Device Manager for Windows 7 and Windows Vista, 
a yellow triangle with an exclamation point indicates a 
problem with a device. To view the problem 
description, right-click the device and select 
Properties. A gray circle with a downward pointing 
arrow means that a device is disabled. To enable the 
device, right-click the device and select Enable. To 
expand a device category, click the right pointing 
triangle next to the category. 

NOTE: In Windows XP, a red circle with a white X indicates a disabled device. 

NOTE: When Windows detects a system error, a dialog box is displayed. If you choose to send the report, Microsoft 
Windows Error Reporting (WER) collects information about the application involved in the error and sends the 
information to Microsoft. 

Custom Installation 
Options 

Disk Cloning 
Installing an OS on a single computer 
takes time. Imagine the time it would 
take to install operating systems on 
multiple computers, one at a time. To 
simplify this activity, you can use the 
Microsoft System Preparation (Sysprep) 
tool, as shown in the figure, to install and 
configure the same OS on multiple 
computers. Sysprep prepares the OS with 
different hardware configurations. With 
Sysprep and a disk cloning application, 
technicians can quickly install the OS, 
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complete the last configuration steps, and install applications.  

Disk Cloning  

Disk cloning creates an image of a hard drive in a computer. For disk cloning, follow these steps: 

Step 1. Create a master installation on one computer. This master installation includes the OS, software applications, 
and common configuration settings that will be used by the other computers in the organization.  

Step 2. Run Sysprep.  

Step 3. Create a disk image of the configured computer using a third-party disk-cloning program.  

Copy the disk image onto a server. When the destination computer is booted, a shortened version of the Windows setup 
program runs. The setup installs the drivers for the hardware components, creates user accounts, and configures 
network settings to finish the installation. 

Other Installation Methods 
A standard installation of Windows 7 is sufficient for most computers used in a home or small office environment. A 
custom installation of Windows 7 can save time and provide a consistent configuration across computers on a large 
network. When deploying Windows to multiple computers, technicians may elect to use a pre-installation environment 
such as Windows PE. Pre-installation environments are basic operating systems that enable a user to partition and 
format drives, or start an installation from a network. 

Windows 7 has several different types of custom installations. 

• Network Installation - Requires all setup files to be copied to a network server 

• Preboot Execution Environment (PXE) Installation - Uses a PXE boot program and a client’s network card 
to access the setup files 

• Unattended Installation - Uses a network distribution point that uses an answer file 

• Image-based Installation - Uses Sysprep and a disk-imaging program, such as ImageX, that copies an image 
of the OS directly to the hard drive with no user intervention 

• Remote Installation - Downloads the installation across the network. The installation can be requested by the 
user or forced on to a computer by an administrator.  

NOTE: To simplify OS deployment across an organization, consider using an OS Deployment Feature Pack using 
Microsoft System Center Configuration Manager (SCCM). 

Network Installation  

To install Windows 7 or Windows Vista over a network, follow these steps: 

Step 1. Prepare the computer by creating a NTFS partition of at least 5 GB. You must make the partition bootable and 
include a network client. You can also use a boot disk that contains a network client so that the computer can connect 
to a file server over the network.  
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Step 2. Copy the installation media to the network server. Make sure to share the directory so that clients can connect 
and use the files. 

Step 3. Boot the computer and connect to the shared directory. 

Step 4. From the shared directory, run the setup program, setup.exe, located in the directory called Sources. The setup 
program copies the installation files to your hard drive. After the installation files have been copied, the installation 
continues. 

To install Windows XP over a network, follow these steps: 

Step 1. Prepare the computer by creating a FAT or FAT32 partition of at least 1.5 GB. You must make the partition 
bootable and include a network client. You can also use a boot disk that contains a network client so that the computer 
can connect to a file server over the network.  

Step 2. Copy the Windows XP installation files (the I386 folder from the installation disc) to the network server. Make 
sure to share the directory so that clients can connect and use the files.  

Step 3. Boot the computer and connect to the shared directory.  

Step 4. From the shared directory, run the setup program, WINNT.EXE. The setup program copies the installation files 
from the network onto your hard drive. After the installation files have been copied, the installation continues. 

PXE Installation  

A PXE installation uses a method similar to a network installation. The only difference is that a PXE installation uses a 
PXE boot file instead of a boot disk. The PXE boot file allows the network interface card (NIC) to communicate with 
the server and obtain setup files. After a client has access to the setup files, it boots to a command window where the 
user is prompted for the network username and password. 

Unattended Installation in Windows 7 
and Vista  

An unattended installation using an 
unattend.txt answer file or an 
autounattend.xml file is the easiest 
alternative installation method to perform on 
a network. To customize a standard 
Windows 7 or Windows Vista installation, 
the System Image Manager (SIM) is used to 
create the setup answer file. You can also 
add packages, such as applications or 
drivers, to an unattended answer file and an 
autounattend.xml file. 

The figure shows an example of an answer 
file. After all questions have been answered, 
the file is copied to the distribution shared 
folder on a server. At this point, you can do 
one of two things: 

• Run the unattended.bat file on the 
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client machine to prepare the hard drive and install the OS from the server over the network.  

• Create a boot disk that boots the computer and connects to the distribution share on the server. You then run the 
batch file to install the OS over the network. 

NOTE: Windows SIM is part of the Windows Automated Installation Kit (AIK). You can download it from the 
Microsoft website. 

NOTE: In Windows XP, you can create an answer file with the application setupmgr.exe, located in the deploy.cab file 
on the Windows XP media.  

Image-based Installation  

When performing image-based installations, begin by completely configuring one computer to an operational state. 
Next, run Sysprep to prepare the system for imaging. A third-party drive-imaging application prepares an image of the 
completed computer, which can be burned on to a DVD. You can then copy the image on to computers with compatible 
Hardware Access Layers (HALs) to complete the installation of multiple computers. After the image is copied, boot up 
the computer, but you might have to configure some settings, such as the computer name and domain membership. 

Remote Installation  

With Remote Installation Services (RIS), the process is similar to an image-based installation, except you do not use a 
drive-imaging utility. You use an RIS network shared folder as the source of the Windows OS files. You can install 
operating systems on remote boot-enabled client computers. You can also start user computers that are connected to the 
network with a remote boot disk or network adapter capable of booting the computer. The user then logs on with valid 
user account credentials. 

System Recovery Options 
When a system failure occurs users can employ the following recovery tools: 

• System Recovery Options 

• Automated System Recovery (Windows XP Professional only) 

• Factory Recovery Partition 

System Recovery Options  

The System Recovery Options are a set of tools that allow users to recover or restore an operating system when it has 
failed. The System Recovery Options are a part of the Windows Recovery Environment (WinRE). WinRE is a recovery 
platform based on the Windows Preinstallation Environment (PE). Windows PE is a basic operating system created to 
prepare a computer for Windows installation and help users troubleshoot operating system failures when no OS is 
available.  

WinRE can be accessed by pressing and holding the F8 key when starting a computer. Once the Advanced Boot 
Options screen appears, highlight Repair your computer and press Enter to access the System Recovery Options. 
You can then use system recovery tools to repair errors that prevent system startup. The following tools are available in 
the System Recovery Options menu: 
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• Startup Repair – Scans the hard drive for problems and automatically fixes missing or corrupt system files that 
prevent Windows from starting 

• System Restore – Uses restore points to restore Windows system files to an earlier point in time 

• System Image Recovery - Creates a system image that replicates the system drive that Windows requires to 
operate 

• Windows Memory Diagnostic – Examines computer memory to detect malfunctions and diagnose problems 

• Command Prompt – Opens a command prompt window where the bootrec.exe tool can be used to repair and 
troubleshoot startup issues for Windows. The bootrec.exe utility can be used with the fixmbr command to repair 
the Master Boot Record or the fixboot command to write a new boot sector that is compatible with the OS. This 
command prompt replaces the Recovery Console from Windows XP. 

If Repair your computer does not appear as an option, users can access the System Recovery Options in WinRE by 
booting the computer from installation media or a system repair disc. A system repair disc allows users to access the 
System Recovery Options in the same way that installation media would. Before a system repair disc can be used to 
boot a computer, it must be created. 

To create a Windows 7 system repair 
disc, as shown in Figure 1, follow 
these steps: 

Step 1. Select Start > Control 
Panel > Backup and Restore > 
Create a system repair disc. 

Step 2. Insert a blank disc in the 
optical disc drive and click Create 
Disc. 

Step 3. Test the disc by using it to 
boot the computer.  

Step 4. After the System Recovery 
Options window is displayed, 
highlight the OS that needs to be 
restored and click Next. The 
following tools should be available: 

• Startup Repair 

• System Restore 

• System Image Recovery 

• Windows Memory Diagnostic 

• Command Prompt 
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NOTE: When using a recovery disc, make sure that it uses the same architecture as the OS being recovered. For 
example, if the computer is running a 64-bit version of Windows 7, the recovery disc must use a 64-bit architecture. 

System Image Recovery  

The System Image Recovery utility, as shown in 
Figure 2, is a new recovery option that is included 
in all versions of Windows 7. It allows users to 
back up the contents of their hard drive, including 
personal files and settings, if an operating system 
needs to be restored. 

To create a system image in Windows 7, follow 
these steps: 

Step 1. Select Start > Control Panel > Backup 
and Restore > Create a system image. 

Step 2. Select a location for the system image: 

• On a hard disk - Stores the system image 
on an external hard drive. 

• On one or more DVDs - Burns the 
system image to a DVD. 

• On a network location - Stores the 
system image in a shared folder on a network. 

Step 3. Click Next and confirm the 
selections. A system image is created and 
stored in the selected location. 

Automated System Recovery in Windows 
XP Professional  

You must create an Automated System 
Recovery (ASR) set to use for the recovery. 
The ASR Wizard, as shown in Figure 3, 
creates a backup of the system state, 
services, and OS components. It also creates 
a file containing information about your 
disks, the backup, and how to restore the 
backup. 

Use the following path: 

Start > All Programs > Accessories > 
System Tools > Backup > click the 
Advanced Mode link > Automated System 
Recovery Wizard 
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To restore your system, press F2 after booting the Windows XP installation disc. ASR reads the set and restores the 
disks needed to start the computer. After the basic disk information has been restored, ASR installs a basic version of 
Windows and begins restoring the backup created by the ASR Wizard. 

Factory Recovery Partition  

Some computers that have Windows 7 pre-installed from the factory contain a section of the disk that is inaccessible to 
the user. This partition, called a factory recovery partition, contains an image of the bootable partition created when the 
computer was built. You can use this partition to restore the computer to its original configuration.  

Occasionally, the option to reach this partition is hidden, and you must use a special key or key combination when the 
computer is starting. Sometimes, the option to restore from the factory recovery partition is located in the BIOS. 
Contact the computer manufacturer to find out how to access the partition and restore the original configuration of the 
computer. 

Boot Sequence and Registry Files 

Windows Boot Process 
Understanding the boot 
process in Windows can help 
a technician troubleshoot 
boot problems. Figure 1 
displays the boot sequence 
for Windows 7. 

Windows Boot Process  

To begin the boot process, 
turn on the computer. This is 
called a cold boot. When the 
computer is powered on, it 
performs a Power On Self 
Test (POST). Because the 
video adapter has not yet 
been initialized, errors that 
occur at this point in the boot process are 
reported by a series of audible tones, called 
beep codes. 

After POST, the BIOS locates and reads the 
configuration settings that are stored in the 
CMOS memory. The boot device priority, as 
shown in Figure 2, is the order in which 
devices are checked to locate the operating 
system. The boot device priority is set in the 
BIOS and can be arranged in any order. The 
BIOS boots the computer using the first drive 
that contains an operating system. 
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Hard drives, network drives, USB drives, and even removable magnetic media, such as CompactFlash or Secure Digital 
(SD) cards can be used in the boot order, depending on the capabilities of the motherboard. Some BIOS also have a 
boot device priority menu that is accessed with a special key combination while the computer is starting but before the 
boot sequence begins. You can use this menu to select the device to boot, which is useful if multiple drives can boot the 
computer. 

Windows Boot Loader and Windows Boot Manager in Windows 7 and Windows Vista  

When the drive storing the OS is located, the BIOS finds the Master Boot Record (MBR). At this point, Windows Boot 
Manager (BOOTMGR) controls several installation steps. For instance, if more than one OS is present on the disk, 
BOOTMGR gives the user a chance to select which one to use. If there are no other operating systems, or if the user 
does not make a selection before the timer expires, the following process occurs: 

1. WinLoad uses the path specified in BOOTMGR to find the boot partition.  

2. WinLoad loads two files that make up the core of Windows 7: NTOSKRNL.EXE and HAL.DLL.  

3. WinLoad reads the Registry files, chooses a hardware profile, and loads the device drivers.  

NOTE: If another OS version is on the disk that is Windows Vista or later, BOOTMGR repeats the process. If another 
OS version is on the disk that is Windows XP or earlier, BOOTMGR invokes the Windows XP boot loader (NTLDR). 

NTLDR and the Windows Boot Menu in Windows XP  

When the drive with the OS is located on a computer running Windows XP, the BIOS locates the MBR. The MBR 
locates the OS boot loader NTLDR. At this point, NTLDR controls several installation steps. For instance, if more than 
one OS is present on the disk, BOOT.INI gives the user a chance to select which one to use. If there are no other 
operating systems, or if the user does not make a selection before the timer expires, the following process occurs: 

1. NTLDR runs NTDETECT.COM to get information about the installed hardware.  

2. NTLDR uses the path specified in the BOOT.INI to find the boot partition.  

3. NTLDR loads two files that make up the core of XP: NTOSKRNL.EXE and HAL.DLL.  

4. NTLDR reads the Registry files, 
chooses a hardware profile, and loads the 
device drivers. 

NT Kernel  

At this point, the NT kernel takes over. 
The NT kernel is the heart of all Windows 
operating systems. The name of this file is 
NTOSKRNL.EXE. It starts the login file 
called WINLOGON.EXE and displays the 
Windows Welcome screen. 

 

Startup Modes  
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Windows can boot in one of many different modes. Pressing the F8 key during the boot process opens the Windows 
Advanced Startup Options menu, as shown in the figure. This allows users to select how to boot Windows. The 
following startup options are commonly used: 

• Safe Mode - Starts Windows but only loads drivers for basic components, such as the keyboard and display. 

• Safe Mode with Networking - Starts Windows as for Safe Mode, but also loads the drivers for network 
components. 

• Safe Mode with Command Prompt - Starts Windows and loads the command prompt instead of the GUI. 

• Last Known Good Configuration - Loads the configuration settings that were used the last time that Windows 
started successfully. It does this by accessing a copy of the registry that is created for this purpose. 

NOTE: Last Known Good Configuration is not useful unless it is applied immediately after a failure occurs. If the 
machine is restarted and manages to open Windows, the registry is updated with the faulty information. 

Windows Registry  

The Windows Registry keys are an important part of the Windows boot process. These keys are recognized by their 
distinctive names, which begin with HKEY_, as shown in the figure, followed by the name of the portion of the OS 
under their control. Every setting in Windows, from the background of the desktop and the color of the screen buttons, 
to the licensing of applications, is stored in the Registry. When a user makes changes to the Control Panel settings, file 
associations, system policies, or installed software, the changes are stored in the Registry.  

Each user account has a unique section of the Registry. The Windows login process pulls system settings from the 
Registry to reconfigure the system for each individual user account. 

The Registry is also responsible for recording the location of Dynamic Link Library (DLL) files. A DLL file consists of 
program code that can be used by different programs to perform common functions. As a result, DLL files are very 
important to the functionality of an operating system and any application users may install. 

To ensure that a DLL can be located by the operating system or a program, it must be registered. It is typically 
registered automatically during the installation process. A user may need to manually register a DLL file when a 
problem is encountered. Registering a DLL maps the path to the file, making it easier for programs to locate necessary 
files. To register a DLL file in Windows using the command-line tool, use the following path: 
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Start > Type cmd in the Search Programs and Files bar > Type regsvr32 filename.dll

 

Multiboot 
You can have multiple operating systems 
on a single computer. Some software 
applications may require the most recent 
version of an OS, while other applications 
require an older version. There is a dual-
boot process for multiple operating 
systems on a computer. During the boot 
process, if the Windows Boot Manager 
(BOOTMGR) determines that more than 
one OS is present, you are prompted to 
choose the OS that you want to load, as 
shown in Figure 1. 

To create a dual-boot system in Microsoft 
Windows, the hard drive must contain 
more than one partition. 

The oldest OS should be installed on the 
primary partition or the hard drive marked 
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as the active partition first. Install the second OS on the second partition or hard drive. The boot files are automatically 
installed in the active partition. 

BOOTMGR File  

During the installation, the BOOTMGR file is created on the active partition to allow selecting the OS to boot on 
startup. You can edit the BOOTMGR file to change the order of the operating systems. You can also change the length 
of time allowed during the boot phase to select the OS. Typically, the default time is 30 seconds. This time period 
delays the boot time of the computer by the specified time, unless the user intervenes to select a particular OS. If the 
disk has only one OS, change the time to 5 or 10 seconds to boot up the computer faster. 

NOTE: In Windows XP, the BOOT.INI file fills the role of the BOOTMGR file. 

To change the time to display the operating systems, use the following path: 

Select Start > Control Panel > System and Security > System > Advanced System Settings > click the Advanced 
tab > In the Startup and Recovery area, select Settings 

To edit general boot 
configuration data in 
Windows 7 and Vista, 
use the bcdedit.exe 
command-line tool, as 
shown in Figure 2. To 
access the bcdedit.exe 
tool, use the following 
path: 

Select Start > All 
Programs > Accessories 
> right-click Command 
Prompt > Run as 
administrator > 
Continue > type 
bcdedit.exe 

To edit the boot.ini file in 
Windows XP, use the 
following path: 

Select Start > right-click 
My Computer > 
Properties > Advanced 
tab > in the Startup and 
Recovery area, select 
Settings > click Edit 
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Disk Management Utility 
A multiboot setup requires multiple hard drives or a hard drive that has multiple partitions. To create a new partition, 
access the Disk Management Utility, as shown in Figure 1. You can also use the Disk Management utility to complete 
the following tasks: 

• View drive status 

• Extend partitions 

• Split partitions 

• Assign drive letters 

• Add drives  

• Add arrays 

To access the Disk 
Management utility in 
Windows 7 and Windows 
Vista, use the following path: 

Start > right-click 
Computer > Manage > 
select Disk Management 

To access the Disk 
Management utility in 
Windows XP, use the 
following path: 

Start > right-click My Computer > Manage > select Disk Management 

Drive Status  

The Disk Management utility displays the 
status of each disk, as shown in Figure 2. 
The drives in the computer display one of 
the following conditions: 

• Foreign - A dynamic disk that has 
been moved to a computer from another 
computer running Windows XP 

• Healthy - A volume that is 
functioning properly 

• Initializing - A basic disk that is 
being converted into a dynamic disk 
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• Missing - A dynamic disk that is corrupted, turned off, or disconnected 

• Not Initialized - A disk that does not contain a valid signature 

• Online - A basic or dynamic disk that is accessible and shows no problems 

• Online (Errors) - I/O errors detected on a dynamic disk 

• Offline - A dynamic disk that is corrupted or unavailable 

• Unreadable - A basic or dynamic disk that has experienced hardware failure, corruption, or I/O errors 

Other drive status indicators might be displayed when using drives other than hard drives, such as an audio CD that is 
in the optical drive or a removable drive that is empty. 

Extending Partitions  

In Disk Manager, you can extend primary partitions and logical drives if there is unallocated space on the hard disk. To 
extend a basic disk, it must be formatted with the NTFS file format. Extending a hard disk increases the amount of 
space available on a primary partition or logical drive. Logical drives and system volumes must be extended into 
contiguous space, and the disk type must be converted to dynamic. Other partitions can be extended into noncontiguous 
space, and the disk type must be converted to dynamic  

To extend a partition in the Disk Manager, follow these steps:  

Step 1. Right-click the desired partition. 

Step 2. Click Extend Volume.  

Step 3. Follow the instructions on the screen. 

Splitting Partitions  

If a hard drive is partitioned automatically in Windows 7 and Windows Vista, there is only one partition. If you want to 
split the partition, you can use the Shrink Volume feature. This feature reduces the size of the original partition, which 
creates unallocated disk space that is used to create a new partition. You must format the unallocated space and assign 
it a drive letter. 

To shrink a partition in Windows 7 and Windows Vista from the Disk Management utility, right-click the drive and 
select Shrink Volume. 

Assigning Drive Letters  

You can change, add, and remove drive letters and paths. By default, Windows assigns a letter to a partition or drive 
after it is created or added. You can change the drive designation to any letter as long as that letter is not already in use.  

To change a drive letter in Windows 7 from the Disk Management utility, right-click the drive and select Change 
Drive Letter and Paths. 

Adding Drives  
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To increase the amount of storage space available on a computer, or implement a RAID setup, you can add drives to 
the computer. If the additional hard drive has been installed correctly, the BIOS should automatically recognize it. 
After the drive is installed, you can check if it is recognized using the Disk Management utility. If the disk is available, 
it probably requires formatting before it can be used. If it does not appear, troubleshoot the problem. 

Adding Arrays  

To set up a RAID, two or more drives must be installed in a computer. You can add an array with the Disk 
Management utility. You have the following options: 

• New Spanned Volume - Creates a disk partition that consists of disk space from more than one physical disk. 
The data on a spanned volume is not fault tolerant. 

• New Striped Volume - A dynamic partition that stores data in stripes on more than one physical disk. The data 
on a striped volume is not fault tolerant. 

• New Mirrored Volume - Duplicates data from one disk to one or more additional physical disks. The data on a 
mirrored volume is fault tolerant. 

• New RAID-5 Volume - A dynamic partition that stores data in stripes on more than one physical disk, while 
also providing parity for each stripe. The data on a RAID-5 volume is fault tolerant. 

NOTE: The options available for adding an array are based on system limitations. Not all options may be available. 

To add an array in the Disk Management utility, right-click the desired disk and select an option. 

Directory Structure and File Attributes 
In Windows, files are organized in a 
directory structure. A directory structure is 
designed to store system files, user files, 
and program files. The root level of the 
Windows directory structure, the partition, 
is usually labeled drive C, as shown in the 
figure. Drive C contains a set of 
standardized directories, called folders, for 
the operating system, applications, 
configuration information, and data files. 
Directories may contain subdirectories. 
Subdirectories are commonly called 
subfolders. 

Following the initial installation, you can 
install most applications and data in 
whichever directory you choose. The 
Windows setup program creates 
directories that have specific purposes, 
such as storing photos or music files. 
When files of the same type are saved to a 
certain location, it is easier to find things. 



	   25	  

NOTE: It is a best practice to store files in folders and subfolders rather than at the root level of a drive. 

Drive Mapping  

In Windows, letters are used to name physical or logical drives. This process is called drive mapping. A Windows 
computer can have up to 26 physical and logical drives, because there are 26 letters in the English alphabet. Drives A 
and B have traditionally been reserved for floppy disk drives, and drive C is reserved for the primary, active partition. 
In Windows Vista and Windows 7, you can assign drives A and B to volumes if you do not have floppy drives. An 
optical drive is traditionally labeled as drive D. The maximum number of additional drives is dependent on the 
hardware of a specific computer. 

Mounting a Volume  

With the NTFS file system, you can map a drive to an empty folder on a volume. This is referred to as a mounted drive. 
Mounted drives are assigned drive paths instead of letters and are displayed as a drive icon in Windows Explorer. 
Windows Explorer is a tool that allows users to view all the drives, folders, and files on a computer in an organized 
manner. Use a mounted drive to configure more than 26 drives on your computer or when you need additional storage 
space on a volume. 

To mount a volume in Windows, follow these steps: 

Step 1. Select Start > Control Panel > Administrative Tools > Computer Management. 

Step 2. Click Disk Management in the left pane. 

Step 3. Right-click the partition or volume to mount. 

Step 4. Click Change Drive Letter and Paths. 

Step 5. Click Add. 

Step 6. Click Mount in the following empty NTFS folder. 

Step 7. Browse to an empty folder on an NTFS volume or create one, and click OK. 

Step 8. Close Computer Management. 

User and System File Locations 
User File Locations  

By default, Windows 7 and Windows Vista stores most 
of the files created by users in the folder 
C:\Users\User_name\. Windows XP uses the folder 
C:\Documents and Settings\User_name\. 
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Each user’s folder contains folders for music, videos, websites, and pictures, among others, as shown in Figure 1. Many 
programs also store specific user data here. If a single computer has many users, each user has their own folder 
containing their favorites, desktop items, and cookies. Cookies are files that contain information from web pages that 
the user has visited. 

System Folder  

When the Windows OS is 
installed, all files that are used to 
run the computer are located in the 
folder C:\Windows\system32. The 
content of the Windows System 
Folder is shown in Figure 2. 

Fonts  

The folder C:\Windows\Fonts 
contains the fonts installed on the 
computer. Fonts come in several 
formats, including TrueType, 
OpenType, Composite, and 
PostScript. Some examples of font 
typefaces are Arial, Times New 
Roman, and Courier. You can 
access the Fonts folder through the 
Control Panel. You can install 
fonts using the File > Install New 
Font menu.  

Temporary Files  

The Temporary Files folder contains files created by the OS and programs that are needed for a short period of time. 
For example, temporary files might be created while an application is being installed to make more RAM available for 
other applications. 

Almost every program uses temporary files, which are usually automatically deleted when the application or the OS is 
finished using them. However, some temporary files must be deleted manually. Because temporary files take up hard 
drive space that could be used for other files, it is a good idea to delete them as necessary every two or three months.  

In Windows Vista and Windows 7, temporary files are usually located in the following folders: 

• C:\Windows\Temp 

• C:\Users\User_Name\AppData\Local\Temp 

• %USERPROFILE%\AppData\Local\Temp  

In Windows XP, temporary files are usually located in the following folders: 

• C:\Temp 

• C:\Tmp 
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• C:\Windows\Temp 

• C:\Windows\Tmp 

• C:\Documents and Settings\%USERPROFILE%\Local Settings\Temp 

NOTE: %USERPROFILE% is an environment variable set by the OS with the username that is currently logged on to 
the computer. Environment variables are used by the operating system, applications, and software installation 
programs.  

To see the environment variables that are configured on Windows 7, use the following path: 

Start > Control Panel > System > Advanced System Settings > Advanced tab > Environment Variables 

To see the environment variables that are configured on Windows Vista, use the following path: 

Start > Control Panel > System > Advance system settings > Advanced tab > Environmental Variables 

To see the environment variables that are configured on Windows XP, use the following path: 

Start > Control Panel > System > Advanced > Environment Variables  

Program Files  

The Program Files folder is used by most application installation programs to install software. In 32-bit systems, 
programs are usually installed in the folder C:\Program Files. In 64-bit systems, 64-bit programs are usually installed 
in the folder C:\Program Files, while 32-bit programs are usually installed in the folder C:\Program Files (x86). 

File Extensions and Attributes 
Files in the directory structure adhere to a Windows naming 
convention: 

• A maximum of 255 characters is allowed.  

• Characters such as a slash or a backslash (/ \) are not 
allowed.  

• An extension of three or four letters is added to the 
filename to identify the file type.  

• Filenames are not case sensitive.  

By default, file extensions are hidden. To display the file 
extensions you must disable the Hide extensions for known file 
types setting in the Folder Options control panel utility, as shown 
in the figure. 

To display file extensions, use the following path:  

Start > Control Panel > Folder Options > View > uncheck 
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Hide extensions for known file types 

The following filename extensions are commonly used: 

• .docx - Microsoft Word (2007 and later) 

• .txt - ASCII text only  

• .jpg - Graphics format  

• .pptx - Microsoft PowerPoint  

• .zip - Compression format  

The directory structure maintains a set of attributes for each file that controls how the file can be viewed or altered. 
These are the most common file attributes: 

• R - The file is read-only.  

• A - The file will be archived the next time that the disk is backed up.  

• S - The file is marked as a system file, and a warning is given if an attempt is made to delete or modify the file.  

• H - The file is hidden in the directory display.  

Application, File, and Folder Properties 
To view or change the properties of an application, file, or folder, 
right-click the icon and select Properties. 

Application and File Properties  

The Properties view, as shown in Figure 1, for an application or file 
may contain the following tabs: 

• General - Displays basic information, including location and 
the attributes. 

• Security - Provides the option to change file access 
permissions for user accounts and the system. 

• Details - Displays basic information for the file, including 
attributes. 

• Compatibility - Provides options for configuring file 
compatibility mode and operational settings. In Windows 7, 
compatibility mode allows a user to run a program created 
for earlier versions of the Windows OS. For Windows Vista 
and Windows XP, the number of options available in 
compatibility mode is limited.  
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Folder Properties  

The Properties view, as shown in Figure 2, for an 
individual folder may contain the following tabs: 

• General - Displays basic information, such as 
location and size. Provides options to change 
attributes, such as making a folder read-only or 
hidden. 

• Sharing - Displays options for folder sharing. 
Users can share folders with computers on the 
same network. Password protection settings can 
also be configured. 

• Security - Displays options for basic and 
advanced security settings. 

• Previous Versions - Displays options for 
restoring a folder from a previous version. 

• Customize - Displays options for customizing the 
appearance of the folder and optimizing it for 
specific file types, such as music or photo files. 

Shadow Copy  

Shadow Copy is a feature of Windows Operating 
Systems that automatically creates backup copies of files 
and data on a hard drive. It can be found under the 
Previous Versions tab, and is often referred to as the previous versions feature. Shadow Copy requires the hard disk to 
be formatted as NTFS and works in conjunction with System Restore and Windows Backups. Before Shadow Copy can 
be used, it must be enabled. To enable Shadow Copy, use the following path: 

Start > Control Panel > System Protection link > Click the checkboxes next to the desired drives > Click OK. 

After	  Shadow	  Copy	  has	  been	  enabled,	  users	  can	  view,	  copy,	  or	  restore	  previous	  versions	  of	  file.	  Selecting	  the	  
view	  option	  will	  open	  the	  file	  as	  read-‐only,	  while	  the	  copy	  option	  will	  save	  an	  older	  version	  of	  the	  file	  in	  another	  
folder.	  Restore	  will	  overwrite	  the	  file	  in	  its	  current	  state. 

	  


